# Table of Contents

1.1 Introduction ......................................................................................................................... 3  
1.2 Pre-requisites ....................................................................................................................... 3  
1.3 Getting Started ..................................................................................................................... 3  
1.4 Installation ............................................................................................................................ 3  
1.5 Registration (license activation) ............................................................................................ 5  
  1.5.1 Registering licenses automatically .................................................................................. 5  
  1.5.2 Registering licenses manually ....................................................................................... 8  
1.6 Opening protected documents ............................................................................................... 10  
1.7 Safeguard Viewer Toolbar ..................................................................................................... 12  
  1.7.1 Menu Options ................................................................................................................ 12  
  1.7.2 Page Scroller .................................................................................................................. 16  
1.8 Safeguard Viewer Library ...................................................................................................... 17  
  1.8.1 Searching for files ......................................................................................................... 18  
  1.8.2 Folders .......................................................................................................................... 18  
1.9 Safeguard Viewer Settings menu ............................................................................................ 22  
1.10 Ways of adding documents/licenses to Safeguard Viewer ................................................... 28  
  1.10.1 Email .......................................................................................................................... 28  
  1.10.2 Web Site Link .............................................................................................................. 31  
  1.10.3 iTunes ......................................................................................................................... 31  
  1.10.4 Wi-Fi upload ................................................................................................................. 31  
  1.10.5 NAS ............................................................................................................................. 32  
  1.10.6 Cloud file storage (i.e. Dropbox, Microsoft SkyDrive, etc.) ......................................... 32  
1.11 Document controls ............................................................................................................. 36  
1.12 De-installation ..................................................................................................................... 36  
1.13 Upgrading the Viewer ......................................................................................................... 36  
1.14 Troubleshooting ................................................................................................................. 36
1.1 Introduction

Safeguard Secure PDF Viewer enables you to view protected PDF files that have been published in .PDC format on your iOS device.

Safeguard Viewer is a standalone application that controls what you can do with protected PDF files (for example how long you can view them for, whether you can print them, etc.). These document controls are set by the publisher of the document and cannot be altered by yourself.

1.2 Pre-requisites

1. Safeguard Viewer supports iOS 8.1 and above

2. The Viewer will not run on devices that have been jailbroken.

1.3 Getting Started

The document owner (publisher) will have sent you an email with details of how to install the Viewer and register (activate) your license.
Diagram 1: Viewer Registration Email

Welcome to Locklizard protected files service

Locklizard has authorized you to use their protected PDF files. Select your operating system below and follow the instructions on the page to install the Viewer, activate your license, and view protected files.

Operating System

- Windows
- Mac
- iOS
- Android

Your license

To view documents from Locklizard you must activate your license:

Sarah hartnell License

NOTE: Your license file may also be supplied as an attachment to this email (.llv and .zip files).

Protected Files

Document licenses and controls are set by Locklizard. You must contact support@locklizard.com if you have any questions about them.

NOTE: License File

If you do not receive this email, or your license file has not been sent to you by other means then contact the publisher. You cannot view Locklizard Secure PDF Files without first activating your license.
1.4  Installation

1. Make sure your Operating system has installed all the latest updates.

2. Install the PDCViewer ipa app by downloading it from the Apple App Store. Then press the Install button.

3. Once the application has installed a new app icon, PDCViewer, will be displayed on the Home screen.

![Diagram 2: PDC Viewer App icon](image)

1.5  Registration (license activation)

These instructions assume you have been emailed a link to a license (.llv file) or have been sent it by email.

For other methods of getting files onto your device see Ways of adding documents/licenses to Safeguard Viewer.

1.5.1  Registering licenses automatically

1. Click on the link to the license file (.llv file).

   **In iOS 12.x and below,** this will load it into the Licenses section of the Safeguard Viewer library and automatically register it.
In **iOS 13.x and above** you will be asked to Download the file.

Do you want to download “Sarah_Hartnell.liv”?  

Download

Select to Download this to Apple’s Downloads Manager. This is the blue folder icon on your Home page.

Open Download Manager, and select the license file. An upload icon will then appear under the battery level indicator.
Select this and then choose the ‘Copy to PDCViewer’ option.

This will copy the license to the Safeguard Viewer library and automatically register it.
2. A message is displayed confirming successful registration.

![Registration successful]

Diagram 3: Registration successful message

**IMPORTANT NOTE:** If this message is **NOT displayed** then see Registering licenses manually below.

**NOTE:** License Activation

Automatic license registration is enabled by default.

You can turn this option off from the Settings menu > Auto Register Licenses.

1.5.2 Registering licenses manually

If a license does not automatically register for some reason, e.g.

- no network connection
- invalid or expired license, etc.
- uploaded via Wi-fi (auto registration is not supported in Wi-fi upload mode)

then you can manually register a license at any time.

To do this, go to the Licenses section of the Safeguard Viewer Library (select the Licenses icon at the bottom of the screen as shown in the image below):
Diagram 4: Safeguard Viewer Library – Licenses section

3. Tap on the license (.llv file).

4. A message is displayed confirming successful registration.

![Registration successful message]

5. The license is greyed out to show it has been activated (registered).

Diagram 5: Registration successful message

Diagram 6: Activated license
1.6 Opening protected documents

These instructions assume you have been emailed a link to a PDC file or have been sent it by email. For other methods of getting files onto your device see Ways of adding documents/licenses to Safeguard Viewer.

1. This is the same process as registering licenses. Click on the link to the PDC file and then select ‘Open in PDCViewer’.

This will load it into the Documents section of the Safeguard Viewer library (shown below).

Diagram 7: Safeguard Viewer Library – Documents

2. Click on the .pdc document to open it.

The welcome screen that is displayed can be turned off in the Settings menu.

Diagram 8: Welcome Message
Chapter 2: Viewing Protected PDF Files

To view a protected PDF file (PDC file), double-click on it in Windows File Explorer.

The protected PDF file is decrypted and displayed in the Safeguard Viewer. As an example, you might see something like this:

**NOTE: License Activation**

If you try and open a document before you have registered (activated your license) the following message will be displayed “You need to activate the license sent to you by the Publisher of the document before you can view it.” Refer to Registration (license activation) above.
1.7 Safeguard Viewer Toolbar

The Toolbar is displayed when you open a document.

Diagram 10: Viewer Toolbar

- To hide the Toolbar tap on the document.
- To reveal the Toolbar tap on the document again.
- The page number and number of pages \(21/44\) is displayed at the top left of the document when the toolbar is visible.

1.7.1 Menu Options

The following options are available:

1.7.1.1 Close

\(\times\) closes the document

1.7.1.2 Search

search for text

Diagram 11: Searching for text

- Select \(\times\) to clear the search entry
- Use \(\downarrow\) to search forwards and \(\uparrow\) to search backwards
1.7.1.3 Rotation Lock

lock the rotation of the document. The icon changes to a locked status when rotation lock is active.

1.7.1.4 Document Info

view info about the document and contact the document owner (publisher)

1.7.1.5 Bookmark

add and display custom bookmarks

- To add a bookmark select
- To remove a bookmark swipe left on it and select the Delete option
- Click on an entry to take you to a bookmark you have previously added
- To exit bookmarks tap anywhere on the document

Diagram 12: Custom bookmarks
1.7.1.6 **Highlight**

Highlight text and images

Mark an area on a page for later review with a rectangle box, freehand selection, or straight line.

2.2.6 Viewing multiple pages (book format)

If you want to view pages side by side (just like in a book) then select the Page Layout > Facing option from the View menu.

You can adjust the document display size until you see the pages fully on the screen.

2.2.7 Menu bar display

If you have unchecked the view menu bar option and the toolbar option and would like the menu bar to re-appear then press the escape key (ESC) on your keyboard.

2.2.8 Full screen mode

The combination keys Ctrl+L can be used to switch between full screen mode and normal mode.

This option is also available from the View menu and by pressing the button on the task bar.

1. **Printing**
   - Whilst in full screen mode, Ctrl+P can be used to display the print dialog (but only if printing has been allowed).

2. **Searching for text**
   - Ctrl+F can be used to display the find (search) dialog.

3. **Zooming in & out of a document**
   - You can use the + and – buttons on the numeric keypad section of your keyboard to zoom in and out of a document.
Tap on the highlight button to enter highlight mode. This displays the highlight toolbar:

Diagram 14: Highlight toolbar

- freehand style highlight
- rectangle highlight (default)
- underline highlight
- save highlights
- clear all highlights on the current page
- clear ALL highlights in this document
- close the toolbar

**NOTES:**

- Highlights are only available in Vertical scroll mode
- Your previously selected highlight style will be remembered
- Screen rotation is locked whilst in highlight mode
- The thumbnail page scroller is hidden whilst in highlight mode
- If you uninstall Safeguard Viewer then all highlights will be lost
1.7.1.7 **Table of Contents**

- display the table of contents
  - Select ▶ to expand or close a level
  - To **exit** the table of contents tap anywhere on the document

![Diagram 15: Table of contents with expanding sections]

### NOTE: Table of Contents toolbar icon

This icon is only displayed in the toolbar if a document has a Table of Contents.

1.7.2 **Page Scroller**

When the toolbar is displayed a page scroller is shown at the bottom of the document enabling you to quickly navigate to a page.

You can turn this feature off from the Settings menu > View Settings > Thumbnail Page Scroller > Never display, or choose to display it all the time.

![Diagram 16: Page thumbnail scroller]
1.8 **Safeguard Viewer Library**

The Safeguard Viewer library is displayed every time you select the PDCViewer app icon.

Any .pdc or .llv files you upload to the iPad are stored in the Safeguard Viewer library. Documents (.pdc files) are stored in the Documents section and Licenses (.llv files) in the Licenses section.

If you press down on a filename then a menu will appear enabling you to delete, rename, open files, and show document info.

Diagram 17: Viewer Library – Documents section
1.8.1 Searching for files

Use the search facility at the top of the library window.

![Search facility screenshot]

Diagram 18: Search facility

Your search entry is automatically filtered as you type.

**NOTE: Search and Folder View Mode**

The search facility is NOT available in folder view mode.

1.8.2 Folders

If the option ‘Show Folders’ is on (activated from the Safeguard Viewer Settings menu) then a folder view will be displayed instead of a list view of all your documents.

![Folder view screenshot]

Diagram 19: Folder view

The folder ‘Inbox’ is a specific folder created by the system to store/transfer pdc/llv files from third-party apps (email, drop box etc.). When you open a pdc/llv files from another app, the system transfers the file to the Inbox folder and then launches Safeguard Viewer. The Inbox folder cannot be renamed. If you delete the Inbox folder and open a pdc/llv file from a third party app, the Inbox folder is created again and the file is stored there.
NOTE: iTunes

iTunes cannot share/download/upload into specific folders.

Files uploaded via iTunes will always be uploaded to the root folder, and those moved into a different folder cannot be accessed with iTunes.

1.8.2.1 Adding folders

To add a new folder, select the button at the top right of the library. The settings button in the left corner will change to . Select this button to add a new folder in the current location.

1.8.2.2 Moving files into folders

To move files or folders, select the button at the top right of the library. Select the files or folders to move, select the button from the bottom left toolbar, and then select the destination folder from the pop-up window.

1.8.2.3 Renaming files and folders

To rename a file/folder, press down on a file/folder name and choose Rename from the pop-up menu. The following dialog is then displayed where you can enter the new folder name.

Diagram 20: Folder rename
1.8.2.4 **Displaying document information**

Press down on the filename and then select **Show Info** from the pop-up menu to display the controls that have been applied to a document.

![Diagram 21: Document Info](image)

1.8.2.5 **Searching for files within folders**

To search for documents in the library you have to toggle back to file view since the search option is NOT available in folder view mode.

1.8.2.6 **Deleting files and folders**

- **Deleting individual files & folders**
  
  Press down on the filename and then select **Delete** from the pop-up menu. Alternatively, swipe the file/folder left or right to reveal the Delete button.

- **Deleting multiple/all files & folders**
  
  Select the button at the top right of the library.

  You can then select multiple files/folders individually or select all of them by using the button (bottom right of library) and then selecting the button to delete them.
Diagram 22: Selecting a folder for deletion

NOTE: Deleting Folders
Deleting a folder will delete all files within that folder.

Diagram 23: Selecting all files for deletion
1.9 Safeguard Viewer Settings menu

From the Safeguard Viewer Settings menu you can change Safeguard Viewer program settings.

To open Settings select the gear button in the top left of the Safeguard Viewer library.

Diagram 24: Safeguard Viewer settings menu
The following options are ON by default:

- Remember last page
- Mark used license
- Auto register license
- Show document cover

### 1.9.1.1 Sort by date

Files are sorted by the date when they were created/uploaded or just how the system retrieves them. If this option is off then sorting is done by the system which is a little faster (usually this is alphabetically but it is not guaranteed).

### 1.9.1.2 Mark used license

Licenses you have activated (registered) will be greyed out and have a check mark next to their name.

### 1.9.1.3 Auto register licenses

License files are automatically registered when they are loaded into the Viewer library. Auto registration occurs when an llv file arrives in the Viewer library – this could be via an email or web page link, or shared/opened from other app (like iTunes, dropbox, etc.). Licenses uploaded via Wi-Fi will NOT automatically register and therefore require manual registration.

If a license has been successfully registered a message is displayed confirming registration. If a license cannot be automatically registered (i.e. no wi-fi connection, expired or invalid license, etc.), no error is displayed and you will have to register the license(s) manually.

### 1.9.1.4 Show document cover

After a document is successfully opened, its first page will be used as cover (just like thumbnails) in the documents list, so you can distinguish between documents quicker.

### 1.9.1.5 Double tap to open

To open a document or register a license you must use double tap, not just a single tap/selection.
1.9.1.6  **Remember last page**

Remembers the last page viewed. Next time you open the document it will open at that page.

1.9.1.7  **Keep screen on**

When reading a document the screen will not standby/dim and turn off, it will stay on so you can read without any interventions.

1.9.1.8  **Show folders**

Allows you to create and manage folders in which you can store documents, rather than just showing them as a single list.

**NOTE:** If this feature is turned on then the library search facility is not available.

1.9.1.9  **View settings**

Configure how you want to scroll through the document (horizontally or vertically), show single or double page view, the thumbnail page scroller, and the text quality.

---

![Diagram 25: Document View Settings](image)

---

Safeguard iOS Viewer v1.0.19 - Rev 1.16  ©2020 Locklizard Ltd  Page | 24 of 36
• **Page Style**
  Select how you want to scroll through the document. Note that:
  o Highlights are only available in Vertical scroll mode.
  o Single and side by side view only support horizontal scrolling.

• **Thumbnail page scroller**
  This displays the page scroller at the bottom of a document. The default setting is to display when the toolbar is visible.

• **Render Quality**
  If you are viewing a large document on older devices with limited memory (i.e. 1GB of DRAM is only available on the iPad mini 3 and below) and the document is very slow or crashes regularly, then choose a lower render quality in order to save on memory. It does not matter how much flash memory your device has as Safeguard Viewer uses DRAM for displaying protected PDF documents.

1.9.1.10 *Use only Wi-Fi*

Instructs the Viewer to only connect when a Wi-Fi internet connection is available (so it doesn't use mobile data via a SIM to consume more expensive bandwidth).

When this option is turned on and a connection is required but no Wi-Fi is available, a message is displayed if a mobile Internet connection is available.

If the option is turned off, the Viewer will connect to the server regardless of the available connection type (Wi-Fi or mobile).

1.9.1.11 *Wi-Fi upload*

Here you configure your Wi-Fi upload settings so you can upload PDC files and licenses to your device via your local Wi-Fi network.

Click on this to show the Wi-Fi Upload Settings dialog where you can enter the Port number and your username and password.
• **Ask for Password**
  Turn on 'Ask For Password' if you Safeguard Viewer to request a username and password before you can upload files. This is useful if you are using an unsecured/shared Wi-Fi network.

1.9.1.12 **Remove Keystore**

Deletes the Viewer keystore.

You may want to use this feature if the document publisher tells you they have extended your account or document expiry date but this information is not being picked up by the Viewer.

- If you use this option you will have to register again to access documents. Any licenses you have uploaded into the Viewer library will be marked as unused - you have to tap on each license in order to register it again.

- Any bookmarks you have created will be lost.

- Any last pages remembered (Settings menu > Remember Last Page) will be lost, so documents will now open again at page 1.

1.9.1.13 **Welcome tips at startup**

A welcome popup with swipe support is displayed when the Viewer loads displaying information on how the Viewer works and what you need to do to get started.
1.9.1.14  **License Agreement**
Displays the Locklizard license agreement.

1.9.1.15  **Online product manual**
Displays this manual.

1.9.1.16  **Crash Report**
Displays crash reports. These can be emailed to Locklizard support.

1.9.1.17  **About**
Displays the app name, version number, and your iOS version number.
1.10 Ways of adding documents/licenses to Safeguard Viewer

These instructions for items 3-5 assume you already have protected PDF files (.pdc files) and licenses (.llv files) on your computer or LAN.

If 'Auto Register Licenses' is on (Settings Menu > Auto Register Licenses) then any .llv files you upload will be automatically registered – except for those uploaded via Wi-Fi.

1.10.1 Email

If license files (.llv files) and PDC files have been sent as attachments by email, then clicking on these will:

- **In iOS 12.x and below**, it will automatically load them into the Safeguard Viewer library

- **In iOS 13.x and above**, you will be asked to Download the file to Apple’s Download Manager. In Download Manager, select the license file and then the upload icon

  ![Diagram 27: Opening a license file](image)

  This will load the license file into the Licenses section of the Safeguard Viewer library and automatically register it.
1.10.1.1 **Gmail instructions**

Click on the license file link and then choose your Browser to open it.

![Diagram 28: Clicking on a license file link in Gmail](image)

Then select the upload icon and select the ‘Copy to PDCViewer’ option:
Diagram 29: Opening a license file in Safeguard Viewer
1.10.2 Web Site Link

Clicking on a link to an Ilv or PDC file on a web page will:

- **In iOS 12.x and below,** it will automatically load them into the Safeguard Viewer library
- **In iOS 13.x and above,** you will be asked to Download the file to Apple’s Download Manager. In Download Manager, select the license file and then the upload icon. Then select the option ‘Copy to PDCViewer’. This will load the license file into the Licenses section of the Safeguard Viewer library and automatically register it.

⚠ NOTE: Support web browsers

All popular browsers (Safari, Firefox, Chrome, Opera) are supported. Microsoft Edge is NOT supported.

1.10.3 iTunes

With your device connected to your computer, load iTunes, navigate to Apps > File Sharing and select “PDCViewer”. Click on the Add button to upload PDC files and licenses to the Safeguard Library.

To see the files, launch PDCViewer on your iOS device (by selecting the PDCViewer app icon), or refresh the lists by selecting the “pull to refresh option”.

1.10.4 Wi-Fi upload

You can upload PDC files and licenses to your device via your local Wi-Fi network.

In the Safeguard Viewer Library, tap the top-right icon 📞 to enter edit mode and then select the 📺 icon to begin the Wi-Fi upload process.
A message is displayed asking you to connect with your computer browser to a local address (like http://192.164.0.13:8080). On your computer, open your browser and navigate to that address. **NOTE:** your computer must be connected to the same Wi-Fi network as your iOS device. You will see a web page with upload options for files and licenses - select them from your computer and click upload, and repeat the operation until all of your files are uploaded.

Click on “Finish Wi-Fi Upload” in the Safeguard Viewer when you are done to finish the upload process.

### 1.10.5 NAS

You can browse for PDC (documents) or LLV (license) files on your NAS device just like any other file using the File Explorer application provided with your NAS. Select a PDC or LLV file, right-click on it, then select "Copy to PDCViewer" to add it to the Safeguard Library.

If the File Explorer application provided with your NAS does not work (for example, the PDC Viewer opens but nothing appears in the window) then use FE File Explorer or a similar third party application.

### 1.10.6 Cloud file storage (i.e. Dropbox, Microsoft SkyDrive, etc.)

Install a cloud file storage system on your computer and your iOS device and follow the instructions to synchronize files between devices.

#### 1.10.6.1 Dropbox instructions

One way of transferring files from a PC or Mac computer to the iPad is to use an application known as Dropbox. This creates a 'cloud' file storage system that allows you to upload files, movies, pictures and so on, that you can share across your account or also with other people. So you can use it to make PDC files downloaded onto your PC/Mac available to upload to your iPad.

To do this you need to download the Dropbox application on the iPad, and that means setting up an account with Dropbox as well as having an Apple ID. Dropbox may be found in the Apple app store, or at [www.dropbox.com](http://www.dropbox.com).
Once you have installed Dropbox on your iPad, you must then download the Dropbox application onto either the PC or Mac, and log on to the account that you created on the iPad. That links the accounts together. As soon as you have done that, the Dropbox app will open a virtual folder where you can drop files to be synchronised between the PC and the iPad. So from the PC end you can drop files into the Dropbox folder and they will become available to the iPad device dynamically, and at the iPad end, files, pictures and so on that are on the iPad are made available for download into the PC.

Diagram 30: Safeguard files in Dropbox
License Files (.llv): Select the .llv file in Dropbox. This will display the file contents (which you can ignore). Click on the Export button and then select ‘Open in’ and then 'Copy to PDCViewer'. The license will then be added to the Licenses section of the Safeguard Viewer library where you can click on it to register (activate) your license. This process is shown in the diagram above.

Secure PDF Files (.pdc): Select the .pdc file in Dropbox. Click on the Export button and then select ‘Open in’ and then 'Copy to PDCViewer’. The PDC document will then be added to the Documents section of the Safeguard Viewer library where you can click on it to open it.

1.10.6.2 Drive instructions

Select the license file or document and then the Open In menu option.

Diagram 31: Importing a license file in Drive
Then select the More menu options and swipe across to select ‘Copy to PDCViewer’:

Diagram 32: Opening the license file with Safeguard Viewer
1.11 Document controls

Document controls are set by the publisher (document owner) and cannot be changed.

To view controls applied to a document press on a PDC file in the Safeguard library and select Show Info.

1.12 De-installation

1. Press on the PDCViewer application until it starts wobbling.
2. Press the X on the left hand corner of the icon.

De-installation removes the PDC Viewer, the Document and License library, and the Viewer keystore.

1.13 Upgrading the Viewer

When you do an iOS Software Update, Apple will inform you about any updates available.

1.14 Troubleshooting

For specific issues please visit our support knowledgebase.

Search for the keyword in an error message rather than a string of text. For any items not covered here please consult the publisher of the document.